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Classic Style/Basic Style 
Many of our new multifunction devices now have the option to choose between two screen displays, also 

known as graphic user interfaces. These two choices are Classic Style and Basic Style. Each style has different 

benefits based on how the MFD will be used in your environment. Keep in mind you can switch between 

Classic Style and Basic Style at any time, but the default setting must be set by your Blue Technologies 

technician. 

Here is a look at the two styles with a brief description as to how they differ: 

- Classic Style offers the

same user interface as

seen in our predecessor

models.

- Classic style offers access

to advanced functions like:

Book Copy, Booklet

Making, Secure Print and

other optional functions.

- Basic Style offers quick and

simple access to everyday

functions like Copy, Scan and

Fax. These functions have been

streamlined for ease of use in

environments in which simple

workflows are preferred.

- More advanced functions such

as Secure Print, Book Copy and

other functions can be accessed

via Classic Style.
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Copying 

Color Settings 

Auto Color: This setting tells your machine to differentiate between color and B&W 
originals. B&W originals will be copied and metered in B&W. Color originals will be 
copied and metered in color. 

Full Color:  This setting tells your machine to treat all copies as color copies (not 
recommended due to high cost). 

Black:  This Setting tells your machine to copy ALL ORIGINALS in B&W. 

2 Color:  This setting will copy the colors present in an original to one color, while 
leaving black (i.e. text) the same. 

Single Color: This setting will take all color and black from an image and alter it to a 
single color. 
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Paper Supply 

 Index Stock paper is recommended by Konica Minolta 

Tray 1: 500 sheets – Universal 

Tray 2: 500 sheets – Universal 

Tray 3: Various options 

Tray 4: Various options 

Bypass Tray: 150 sheets – Universal 

The bypass tray can hold up to 10 envelopes at a time. 

Paper Thickness: 

8 & 9 Series MFDs and 

Predecessor Models 

Plain Paper: 64 -90 g/m2

Thick 1: 91 -120 g/m2 

Thick 2: 158 – 209 g/m2 

Thick 3: 210 – 256 g/m2 

Thick 4: 257-300 g/m2 

You cannot duplex Thick 4 paper 

I Series Models 

Plain Paper: 60-90 g/m2 

Plain Paper+: 91-105 g/m2 

Thick 1; 106-120 g/m2 

Thick 1+: 121-157 g/m2 

Thick 2: 158-209 g/m2 

Thick 3: 210 – 256 g/m2 

Thick 4: 257-300 g/m2 

You cannot duplex Thick 4 paper 

Basic Style 
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Reducing and Enlarging 

To Reduce or Enlarge a Standard Size 

(8½x11, 8½x14 or 11x17) 

1. Place your original in the document feeder.
By default, the MFP will choose the matching paper size.

2. Select the size paper you would like to copy on.
Your MFP will automatically adjust the zoom to the correct percentage.

3. Press [Start] to copy.

Basic Style Classic Style 

Basic StyleClassic Style
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To Reduce of Enlarge an Object Off the Glass 

1. Place your original face down in the upper left corner of the glass.

2. Select the size paper you want to copy on.

3. Select a preset or select [Zoom].

Basic Style 
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4. Enter in the percentage you would like to enlarge/reduce to by tapping the box in the center, followed
by your desired percentage. 

To avoid wasting paper, you may want to use the [Preview] function. 
This function allows you to see your copy on the touch screen before you make your copy. 

The Preview function is only available in Classic Style. 

If you are happy with how your reduction/enlargement looks, press [Start] to copy. 

If not, select [Cancel] and try a different percentage. 

5. Press Start to make your reduced/enlarged copy.
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1-Sided/2-Sided. Choosing Original -> Output

By default, our MFP’S are set to 1-sided originals -> 1-sided copies. 

To choose another option, simply tap the desired [Original->Output] setting. 

(HINT: The image on the left represents what you have in your hand, your Original(s). The image on the right 

represents what your copies will be, your Output.)  

Selecting Number of Copies/Number of Sets 

Classic Style: 

Select No. of Sets 

then enter your 

desired number of 

copies 

Basic Style: 

Simply enter your 

desired number of 

copies. 

Basic Style 

Basic Style 
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Finishing 
Finishing options are located on the main copy screen under the [Finishing] tab. 

The FS-536, FS-533 & FS-539 staple up to 50 sheets. The FS-540 staples up to 100 sheets. 

FS-539 Shown with Booklet/Fold options       FS-540 Shown with Booklet/Fold options 

Sort: Sorted sets will place pages in sequential order.   1, 2, 3, 4… 

Group: Grouped sets will consist of all page 1’s as a set, all 2’s, all 3’s 

Half Fold: You can [Half Fold] 3 sheets at a time of 8 ½ x11, 8 ½ x 14 and 11 x 17 paper. 

Center Staple and Fold: [Center Staple and Fold] up to 20 sheets at a time of 8 ½ x11, 8 ½ 
x 14 and 11 x 17 paper. 

Tri-Fold: Fold up to three sheets at time of 8 ½ x 11 landscape orientation only. 

Offset: Offsetting your copies will stagger each set by one inch on the finisher when 
completed. 

Hole Punch:  [2-Hole] and [3-Hole] punch are available as options. 

Folding: [Half Fold], [Center Staple and Fold] and [Tri-Fold] are available as options. 

Basic Style 
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Special Application Copying 

Book Copying (Accessible via Classic Mode) 
1 From the main [Copy Screen], select [Application]. 

2. Scroll and select [Book Original].

3. Select [On]. This feature enables [Non-Image Area Erase] which allows you to keep the document feeder
open. It also enables [Centering], which allows the copier to detect the center spine of your book.

4. Choose [Separation] to place each page on a separate copy or select or select [Book Spread] to combine
both pages on to a single sheet.

5. Once you have selected your options, press [Ok].

6. Press the [Start] button to begin scanning.

7. At this time, you may scan subsequent pages of your original book by turning to the next page and
pressing [Start] on each new page.

8. Select [Finish], then [Start] when scanning is complete.
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Booklets (Accessible via Classic Mode) 

Booklets can be made on 8 ½ x 11, 8 ½ x 14 and 11x17 

1. From the default [Copy Screen] select [Application].

2. Scroll and select [Booklet] under the E tab, labeled [Layout].
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3. Select your options and press [Ok].

4. Load your originals in the document feeder in single-sided consecutive order, portrait orientation.

5. Press [Start].

Booklets can be made on 8 ½ x11, 8 ½ x 14 and 11 x 17 paper.

Paper must be loaded in landscape orientation for folding booklets. 

Portrait Landscape 
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General Printing Overview 
- Basic printing settings often can be changed from the Print Dialog Box within the software you are

using. The look of the of the Print Dialog Box will vary depending on what software you are printing

from.

- You can initiate printing by selecting [File – Print] in the upper left-hand corner of your software, or by using

the shortcut [Ctrl+P]. You may also change basic settings such as: Printer, Number of Copies,

Portrait/Landscape and Page Range.

For advanced options, select [Printer Properties]/[Properties]. 

                                                                             

Options within MS Office include: 

1. Print – Select this once ALL OPTIONS have been chosen

2. Number of Copies

3. Selectin your desired printer

4. Page Range

5. Select [Printer Properties] for more options.

- One Sided/Two Sided

- Portrait Landscape

- Paper Size

- Margins

Options from an Adobe PDF viewer include: 

1. Selecting desired printer

2. Select [Printer Properties] for more

options.

3. Number of Copies

4. Page Range

5. Size/Scale Options

6. Portrait/Landscape

7. Preview

8. Print-  Select once ALL OPTIONS have

been Chosen

1 2 

3 

4 
5 

1 2 
3 

4 

5 

6 

7 

8 
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My Tab 
- Selecting [Printer Preferences] or [Preferences] will take you to the Konica Print Driver. From there, you can

select a multitude of settings depending on your desired print output.

- Once you have finished adjusting your options, select [OK]

- The driver is separated in to tabs that focus on different areas of functionality. The driver will open to [My

Tab] by default.

Customizing My Tab 
You can customize [My Tab] to suit your needs. To do so, simply navigate to the option you wish to add to [My 

Tab]. Right-Click on the option then select either [to the LEFT] or [to the RIGHT]. Your selected option will then 

be available in [My Tab]. 

From [My Tab], you may select  from 

settings such as: 

1. Portrait/Landscape

2. Number of Copies

3. Original Size/Paper Size

4. 1 Sided/2 Sided

5. Color/B&W

6. [OK] – Click when you are

finished editing options and are

ready to print.

Right-click on the drop down 

arrow next to the option you 

wish to add to [My Tab], then 

select [to the LEFT] or [to the 

RIGHT] 

1 2 

3 4 

6 

5 
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Basic Tab 

Layout Tab 

 

The [Basic] tab allows you to change 

settings such as: 

1. Output Method

Print

Secure  Print

User Box

2. Zoom

3. Collate/Offset

4. Paper Tray/Paper Type

5. [OK] – Click when you are

finished editing all options and

are ready to print.

The [Layout] tab allows you to 

adjust settings such as: 

1. Combination

2 in 1 

4 in 1 

2. Print Type

1-Sided

2-Sided

Booklet

3. Binding Position

Left 

Right 

Top 

- Image Shift/Binding 

Margin

- Rotate 180 Degrees/Skip 

Blank Pages

-

 [OK] – Click when 

you are finished 

editing all options 

and are ready to 

print. 

1 

2 

3 

4 

5 

1 

2 

3 
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Finishing Tab 

 

Cover Mode Tab 

The [Finish] tab allows you set the 

following finishing options. 

1. Staple

Left 

Right 

2-Position Left

2-Position Right

2-Position Top

2. Center Staple and Fold
(Requires additional accessory) 

3. Punch (Requires additional accessory)

Two hole (left or right)

Three hole (left or right)

4. Fold (Requires additional accessory)

Available options will vary 

depending on your MFD 

model and 

configuration/accessories. 

The [Cover Mode] tab allows you to select 

cover page options. Adding a cover allows 

you to add a different Paper Tray/Paper 

Type as a front/back cover to your 

document. 

1. Front Cover

Blank or Printed 

Source Tray for Cover 

2. Back Cover

Blank or Printed 

Source Tray for Cover 

[OK] 

Click when you have finished 

selecting all options and are ready 

to print. 

[OK] – Click when you are 

finished editing all options and 

are ready to print. 

1 

1 

1

2

3

4 

2 
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Stamp/Composition Tab 

Quality Tab 

The [Stamp/Composition] Tab allows 

you to add: 

1. Watermark

Print a preset or 

custom-made 

watermark on your 

document. 

2. Copy Security

A Copy Protection 

function that embeds 

a pattern that restricts 

copying of your 

document. 

3. Date/Time

4. Page Number

The [Quality] Tab gives you access to color 

and resolution settings. 

1. Select Color

- Auto Color

Images with color are  

printed in color. Images 

without color are  

printed in gray scale. 

- Gray Scale

Prints document in B&W

- Two Color

Black and grey are left

as-is. All colors are

converted to your

chosen color.

2. Resolution

 [OK] – Click when you are 

finished editing all options and 

are ready to print. 

 [OK] – Click when you 

are finished editing all 

options and are ready 

to print. 

2 
1 

1 2 

3 & 4 
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Special Application Printing 

Printing Envelopes on Your Konica MFD 

Settings for Microsoft Word 

1. Open Word. 2. Select [File] Print

3. Select [Printer Properties]. Make sure you have selected your Konica MFD.

4. Under the [My Tab] tab, or the [Basic] tab, change the [Paper Type] to [Envelope].
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5. Select [Ok] on the [Properties] tab.

6. Select [Mailings], then select [Envelope] or use [Mail Merge].

7. Enter your desired address information.

NOTE: If you are using an envelope other than COM10, select [Options], then select the 

corresponding size envelope. 

8. Select [Print] when you are ready.

20



MFP Setup for Envelopes 
When you walk up to you MFP, you will see this screen. 

1. Load your envelope(s) face down/flap up in the bypass tray.

If you are printing envelopes to the bypass tray you can load a maximum of 10 envelopes. 

I series MFDs can print envelopes from tray 1 also. You can load a maximum of 70 envelopes in tray 1. 

Make sure that you slide the lateral guide to fit the envelopes .   

2. Once you have loaded your envelopes, the [Complete] option will appear on the screen. Select

[Complete] and your envelope(s) will begin printing. Press [Start] if prompted.

It must read [Envelope 

Com 10, Envelope] here. 

If it does not, your envelope will 

wrinkle, seal or not print 

properly. Return to step 4 of the 

Word Setup portion and be sure 

to select [Envelope] as the 

Paper Type. 
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Printing Tabs on Your Konica MFD 

For the Windows Driver 
In order to print tabs on your Bizhub MFD you will need to put your tabs in reverse order or purchase reverse 

order tabs.  

1. Download and open your template.

The templates on this website work well.  https://www.mybinding.com/copier-tab-templates.html 

2. Edit your Tabs.

From your templates, you can edit your Tabs by moving your cursor over the text for each tab position, deleting 

the template text and entering your own. 

3. Select [File -> Print] or [Ctrl ->P] when you have finished editing your tabs.

22
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4. Select your printer and then select [Printer Properties].

5. Under the [My Tab] tab, change the [Original Size] to [8.5x11 Tab]. When the promt [“Confirm setting

changes…”] appears, select [Yes]. If you do not receive this prompt, go to the [Basic tab] and set the [Paper

Type] to [TAB].

6. Select [OK]. You may now print.
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At the MFD 
In order to print tabs on your Bizhub MFD you will need to put your tabs in reverse order or purchase reverse 

order tabs.  

7. Grab your reverse order tabs and walk up to your MFD. You should see this screen, which prompts you to

load your tabs in the Bypass Tray.

8. Load your reverse order tabs face down and with tabs facing out in the Bypass Tray.

9. When the [Complete] button becomes available, tap it. Your tabs will begin printing.

Tab 5 on 

bottom 
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Faxing 

To Send a Fax Directly 

1. Load the original(s).

2. Select [Scan/Fax].

3. Select a stored One-Touch destination, or press [10 Keypad] to manually enter a number.

. 

    3a. To manually enter a destination press the [10Key Pad]. Enter your destination number exactly as you 
would dial it. 

Basic Style 
Classic Style 

Classic Style Basic Style 

Classic Style Basic Style 
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4. Configure the optional settings for fax as necessary.

5. Press [Start].

Basic Style 

Classic Style 
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Scanning: 

To Send an Email directly 
1. Load the original(s).

2. Press [Scan/Fax].

3. Select your One-Touch destination.

Classic Style 

Classic Style 

Basic Style 

Basic Style 
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3a. If you need to send to an email address that has not been programmed: 

3a. Enter the desired email address via the keypad. 

In Classic Style: 

Select Direct Input then 

select Email. 

In Basic Style 

Select the + (Plus) sign. 

Classic Style Basic Style 
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4. Configure options for your scan if necessary.

5. Press [Start].

Basic Style 

Classic Style 
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Saving Email Addresses and Fax #’s 

Saving Addresses and Fax Numbers at the MFD 
1. From the Main Menu, select [Address book].

1. Select [New].

2. Select the [Address Type]. Chose Email, Fax, User Box, etc.

Classic Style Basic Style 
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3. Enter the necessary information for your contact.

Email Example 

4. Select Register when you are ready to save your One-Touch destination.

3. Email/Fax/User Box etc...

If entering an email, type the contact's full email address. If entering another type of One-Touch (Fax, User Box...) enter 
the full number or User Box name here. 

*If entering a fax, enter the full number without dashes. Example: 915558675309

2. Index/Favorites

Choose under what letter group to place the contact in the Address book (ABC, DEF...). Choose Favorites to have the 
contact appear on the main Fax/Scan screen. 

1. Name

Enter the contact's name as you would like to appear on the MFP 
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Saving Email Addresses and Fax Numbers From 

Your Computer 

1. First, obtain the IP address from your copier.

1. Select [Utility].

2. Select [Device Information]. The IP Address is located on line [IPv4].

2. Open a new web browser window.

Type the IP address into the address bar and press [Enter]. 

3. Select [Store Address].

4. Select a [One-Touch] to edit, delete or select [New Registration].
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5. For a [New Registration] choose what type of [One-Touch] you would like to create and select [OK].

   From the above screen you can add email addresses, fax numbers, user boxes etc… 

EMAIL EXAMPLE 
6. Enter the necessary information and select [OK].

Note: Enter a name, index location (ABC/DEF…). Selecting [Main] will put the contact on your 

favorites screen. Enter the corresponding email address and select [OK] to save your One-Touch 

destination. 
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Secure Print for Confidential Documents 
The [Secure Print] function is particularly suitable for safely printing highly confidential documents. 

Secure Print allows users to set an ID and Password for print jobs. The print data is then stored in the Secure 

Print User Box and can be retrieved by the user with their ID and Password. With the job not printing until the 

user retrieves it, confidential documents can be kept secure or prevented from being discarded.  

Secure Print (PC) 
1. Within [Properties/Preferences] select the [Basic] tab. Go to [Output Method] and select [Secure Print].

2. Enter an ID and Password then select [OK]. Select [OK] or [Print] again to send your print job. The data

is saved in the [Secure Print User Box].
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Secure Print (Mac) 
Every Mac OS varies slightly. Yours may look different. In Step 1, the objective is to find the Output Method setting. 

1. File Print- Click [Safari] & 2. Under [Output Method] select [Output

Method]. select  [Secure Print].

3. Enter the Username and Password         you 

would like to use for Secure Print.

Select [OK] and select [Print]. Click the box marked [Save 

Settings]. This will save your 

username and password so 

that when you use Secure 

Print in the future you will not 

have to reenter this 

information. 
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Retrieving a Secure Print document from the 

MFD. 
You must use Classic Style to retrieve Secure Print jobs. 

1. Press [Menu].

2. Select [User Box].

3. Select [System] – [Secure Print].

4. Enter the document ID and password, and then select [OK].
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5. Highlight a file to print and then select [Print].  Select [Select All] for multiple documents.

6. Set print options if necessary.

7. Press the [Start] key.
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Printing From and Scanning to a USB 

To Print from a USB Flash Drive 
1. Insert your USB flash drive.

2. In Classic Style select [Print document from External Memory.

In Basic Style select [External Memory Print].

3. Highlight the file you wish to print and then select [Print].

Classic Style Basic Style 

Classic Style 
Basic Style 
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4. Select print options if necessary.

5. Press [Start].

6. Once your document has finished printing you may remove your USB.

Basic Style Classic Style 
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To scan to a USB flash drive. 
Scanning to a USB is disabled by default for security purposes. 

To have this function enabled please contact your Blue Technologies representative. 
This function is available in Classic Style. 

1. Load your original.

2. Insert your USB flash drive.

3. Select [Save a document to External Memory].
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4. Choose file save options if necessary.

4. Press [Start].

5. Once the blue data light turns off your file has been saved. You may remove your USB flash drive.
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User Boxes: 

 To Create a User Box 
1. Enter the IP address of your MFD in the address bar of a web browser.

To find your MFDs IP address, select Utility -> Device Information 
The IP address is listed on line IPV4 

2. Select Box.

3. Select User Box List

4. Select New Registration and enter the following info

Input Number: Select [Use opening number] to 

automatically assign the smallest available number. 

Make note of your User Box number. You will need 

it if printing/saving to your User Box from your 

computer. 

User Box Name: Enter a name for your User Box. 

Password: If you chose you can enter a password to 

protect your User Box. 

Auto Delete Document: Chose how long your 

documents will be saved in the User Box. One day 

is the default setting. 

Select OK when finished to create your User Box. 
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To Save a Document in a User Box From the 

MFD 
This option is available in Classic Style 

1. Load the original.

2. Press [Menu].

3. Press [Box/User Box].

4. Specify a [User Box] to save data. If the [User Box] is password protected, select [Open] to enter the
password.

5. Select [Save].
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6. Select save options if necessary.

7. Press the [Start] key. The file is saved.

44



To Print or Send a Document from the User Box. 
This Function is available in Classic Style. 

1. Press [Menu].

2. Press [User Box].

3. Select desired [User Box] and press [Open].

4. Highlight the document you wish to print/send.

5. Select [Print] or [Send].

6. If sending, select your destination(s) and options.

7. Press [Start].
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 To Save a Document in the User Box From a PC
1. Go to [File>Print].

2. Press [Printer Properties].

3. Under [Output Method], select [Save In User Box].

4. Press the [User Settings] button directly underneath the [Output Method]. Give the file a name you

would like it to save as. You will also need to enter your User Box No. from earlier.

5. Press [OK] twice. You will see your file save to the [User Box].
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Contact Blue Technologies for additional assistance: 

Request Service by Email : 

Order Supplies by Email: 

Accout Support/Customer Service: 

Service and Supply Requests: 

Service@BTOhio.com 

Supplies@BTOhio.com 

(216) 271-4800

(216) 271-5800

Cleveland - Corporate HQ 
5885 Grant Avenue 
Cleveland, OH 44105 
216.271.4800 

Akron/Canton 
5701 Mayfair Road 
North Canton, OH 
44720 330.499.9300 

Columbus 
530 Lakeview Plaza Blvd, Suite A 
Worthington, OH 43085 
614.575.1999 

Mansfield
779 Lexington Avenue
Mansfield, Ohio 44907
567.307.4800

Toledo
6475 Wheatstone Court
Maumee, Ohio 43537
419.504.4800 

Youngstown
6790 Belmont Avenue, Suite A
Girard, Ohio 44420
(330) 822-4800
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